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1  INTRODUCTION 
The ADVISER Person ID Instruction document is provided to assist districts/systems with the assigning 

and updating of the students’ unique ID numbers.  Every student enrolled in a Nebraska school will need 

an ID assigned to them and this student needs to be kept current in the ADVISER Person ID system. 

The student data includes the students’ current grade level, district code, school code and school year.  

Any other changes or corrections, such as name changes or correction of birth dates should also be 

reflected on the student’s record.  The student data being kept current is important for the public and 

special purpose schools reporting student data to ADVISER as well as any schools, including nonpublic 

schools, which use the Direct Certification system. 

The ADVISER Person ID collection is located in the NDE Portal under the Student & Staff tab.  An 

activation code is required to access this collection.  Activation codes can be acquired from the District 

Administrator. 

There are two types of activation codes for the ADVISER Person ID; District and District Read Only.  The 

District code allows the user to search for student ID numbers, create new ID numbers, edit or update ID 

numbers and upload batch files.  The District Read Only allows only the search for student ID numbers.  
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2 MENU TABS 

2.1 Home Tab 
The Home tab will always bring the user back to the Batch Display/Search screen. 

 
District/System Name – Should be the same in all 3 places if user has access to only one district/system.  

If user has access to more than one district/system, the District dropdown box will list all districts the 

user has access to. In order to change the district, in the dropdown menu select the desired district and 

press the SELECT button to confirm. 
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Date range for batches displayed below 

 

Drop-down for selecting the number of batches to display 

Displays the batches that have been submitted during selected date range 

 

NOTE:  Users can also search for a specific BATCH NUMBER, a batch in a specific BATCH STATUS or a 

batch in a specific BATCH TYPE on this page. 
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2.2 Assign Tab 

 

Assign Tab Menu: 

 Enter Online – Entering Individual Students 

 Upload File – Legacy (Student Unique ID) or ADVISER Person ID Formats 

o Both of the above features are only available to users with update access (District 

UserType activation code) 

The Enter Online process, located under the Assign tab, is where an individual student can be assigned 

an ID number.  If a student enters a Nebraska school from out of state or is a new student to the public 

or nonpublic school system, the student will need to be assigned an ID number.  If the system finds a 

student matching the information that was entered in the online submission, the system will either 

assign the new information to the existing ID number or display a near match status for resolution. 

The Upload File process, also located under the Assign tab, is where a student ID file can be uploaded to 

update multiple students with the new school year information as well as to create multiple new 

student ID numbers if needed.  During this process, the system does a comparison of the students’ 

information in the file to the information currently in the system.   

 If the system sees a student with an ID included in the file that exactly matches an existing 

student ID number, the student will be updated with any new information provided in the file 

 If the system sees a student without an ID in the file that it believes matches to a single existing 

student, it will assign the existing student’s ID to the student in your file and update that 

student with any new information provided in the file 

 If the system sees a student without an ID in the file that it believes matches no existing 

students, it will create a new ID for the student in your file using the information provided in the 

file 

 If the system sees a student without an ID in the file that it believes could match several 

existing students, that student in the file will be placed in Near Match status and the user will 

have to choose what to do with that student 
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2.2.1 Enter Online – Individual Student 

 

GENERAL INFORMATION 

All asterisk (*) fields must be completed; First Name, Last Name, Gender and Date of Birth.  Enter the 

student’s legal name, gender and birth date, (i.e. from birth certificate). 

 

ENROLLMENT INFORMATION 

All asterisk (*) fields must be completed.  District will be prepopulated with district name selected on 

the top district drop-down box.  If user has access to more than one district, changing the district in the 

top drop-down and clicking on the SELECT button, will change the District in the Enrollment 

Information.  There are drop-down boxes for Grade, School, District of Residence and School Year. 

Local ID is optional. 

 

Click the ASSIGN ID button when all data has been entered to assign a student an ID number. 

Click the RESET button to clear all data and start over. 

 

NOTE:  It is possible a student entering a district/system as an HP or PK student may already have a student 

ID number.  In this case the system may display a near match which the user must check in order to verify 

the number for the student; or the system will automatically assign the student the ID number that was 

found in the system.  The number the system assigns to the student can be downloaded.  If the result is a 

near match, please see section 2.2.3 for Resolving Near Matches. 

 

After selecting the ASSIGN ID button, the system will return to the Home Screen/Batch Display Screen 

and display the batch which was just created.  The Add Person Online batch will display with the Batch 

Complete status in the table.  Selecting the DOWNLOAD link in the Next Action column will open a dialog 

box asking to either Open or Save the file. 
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Add Person Online Batch 

 
 

The downloaded file will be in text format (.txt) and will be the ADVISER Person ID file format.  The ID 

number the system either created or found for the student will be in this file. 

 
 

2.2.2 Upload File – Multiple Students 
If the district/system has a Student Information System (SIS) that can extract a file for the student ID 

updates, it will more than likely be in the Legacy Student ID format that has been used that past several 

years. 

 

For instructions on how to create a file for the Upload File process, see Appendix A. 

 

The file should be extracted from the SIS in either the .tab, .txt or .csv format (not .html) and should not 

be “opened” once extracted from the SIS.  If needing to view the contents of the file prior to uploading, 

the file must be imported into Excel to maintain the appropriate file formatting.  Follow the instructions 

for importing a text file into Excel from Appendix B. 
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Template:  Select the file format of the file to be uploaded 

Select a file to upload:  Browse local computer to locate the file to be uploaded 

Delimiter:  Depending on the format of your file, select TAB for .txt, Select COMMA for .csv or .txt 

Text Qualifier:  double quotes, single quote, or none 

Select the qualifier type if the file exported from the Student Information System has text 

qualifiers (used in cases where the student’s name might have a comma in it within a comma-

separated values file) or leave blank if the file is exported with no qualifiers 

First row contains headers?:  Select either Yes or No 

Click the UPLOAD button to begin the upload process 

While the file is processing, the Status will be Waiting to Find Matches while attempting to locate the 

students in the file. 

 

Click the Refresh Status button to refresh the display. 

 
 

When the upload is successful, a message like the one below should display. 

 

Click on the Batch Number to return to the Home Screen – Batch Display to view the upload status. 

When Batch Status is Batch Complete, the DOWNLOAD link in the NEXT ACTION column, can be 

selected to download the file. 
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The downloaded file will have all of the students and their ID numbers.  Students in the file upload that 

did not have ID numbers entered for them, will have the numbers the system assigned to them in the 

file download. 

When the file is downloaded, it will be in the ADVISER Person ID file format as a .csv file type and should 

be saved to the local computer rather than opened. 

If needing to view the data in the download file to obtain ID numbers for students that did not have a 

number in the file upload, the file must be imported into Excel.  Do Not double click on the file to open 

it.  Follow the instructions for importing a text file into Excel in Appendix B. 

2.2.3 Reviewing Near Matches 
During the file upload process or the online entry process, if students are found in the system that it 

cannot determine an exact match for, a RESOLVE NEAR MATCHES link will display in the Next Action 

column.  The Status will be Ready for User Review.  Click on the RESOLVE NEAR MATCHES button to 

continue the process. 
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A list of the students’ records that are in the Near Match status will display 

 

Near Matches must be resolved before the process can complete.  Click on the REVIEW & SELECT link in 

the far right column for each of the students to view the student from your batch and their near 

matches. 

The CANCEL SELECTED RECORDS button will cancel all near matches in the list.  No student data will be 

updated.  District would need to return to these students and update them either in another file upload 

or individually. 

The RETURN button will return to the Batch Display/Search screen. 

 

2.2.4 Resolving Near Matches 
On the Review and Select Screen, the top record is the submission record, the data that was either in 

the file uploaded or the data entered in the online section.  The bottom two records are students the 

system found that could be the same student as the submission record.  Click on either the first name, 

last name or the COMPARE to continue. 

Review and Select Screen 

 

NOTE:  The Assign Selected ID button is disabled on this screen.  The only options available would be to 

click on the BACK button to go back to the list of near matches or click on the CANCEL RECORD  button 

to cancel the record.  Cancelling the record removes the near match and the student in the submission 

record does not get assigned or updated. 
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Compare Screen 

The highlighted record in the top section below is the record that was selected to Compare from the 

previous screen and is the record that is in the Near Match Record section in this Side-by-Side view.  

This is the record system found. 

The Submission Record is the student’s information in the file upload or online entry. 

The highlighted fields in the Side-by-Side view are the data that are different between the Submission 

Record and the Near Match Record. 

 

Be sure to review all students’ records in the Near Match to ensure the correct choice is made.  Review 

the information carefully to determine if the Near Match is the same student as the Submission Record.  

The options on this page are: 

Exit – if unsure and to go back to make another selection 

Cancel Submission – which cancels the Near Match 

Create New ID – if all near matches have been reviewed and none of them are the same student as in 

the submission record 

Assign Selected ID – to update the selected ID number to the submission record data 
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When the Near Match is resolved, a screen like the one below should appear.  The DOWNLOAD button 

can be selected to view the result. 

 

2.3 Download Tab 
Download – Location 

 

The Download – Location process will download a file for the district, school and school year selected in 

the dropdown boxes and in the chosen file format. 

If user has access to more than one district, the desired district will need to be selected in the dropdown 

box in the upper right of the screen and click the SELECT button to confirm. 
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All schools within the chosen district will display in the School dropdown box. 

School year choices will begin with the 2018-2019 school forward. 

User can choose the file format, ADVISER Person ID or Legacy Student ID, for downloading the file. 

Depending on the browser a dialog box will display asking the user what to do with the file.  The 

download file will be in text format (.txt) and will include all students and their ID numbers that were 

assigned to the chosen district, school and school year. 

To open the file in Excel, DO NOT “open” the file by simply double clicking on it.  The file must be 

imported into Excel to make changes to the file.  Follow the instructions for importing a text file into 

Excel from Appendix B. 

2.4 Search Tab 
Search - Student 

 

The Search – Student process is for locating an ID number for a student or to assign/update a student’s 

record. 

There are two available searches, Basic Search and Advanced Search. 
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Basic Search 

The Basic Search allows a search by the student information.  Search with as many fields, with as much 

information as is known. Partial names can also be entered to search by as if there is a wildcard entered 

behind what is entered. 
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Advanced Search 

The Advanced Search allows a search by student information and enrollment information.  Search with 

as many fields, with as much information as is known. Again, partial names can be entered to search by 

as if there is a wildcard entered behind what is entered.  A search can be done for students in any 

district or school year, and then edited to share them with your district. 

 

When the search is complete, a list of students will display below.  Each column has a sort feature which 

will assist the user in locating their student in the list.  Click on the student’s first or last name to display 

the Student Information screen. 
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Student Information 

On the Student Information screen, the student’s current information is displayed in the General and 

Enrollment Information sections.  Below the Batch Information is the student’s history.  The Person 

Information will display history information regarding the student.  The District Information will display 

the history information of the District/Districts the student has been reported.  If the staff searching for 

the student has the appropriate access to the ADVISER Person ID collection, there is an EDIT STUDENT 

button at the bottom of the page. 
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Update Person Details 

The student’s information can be edited on the screen.  All of the fields except the Person ID field can be 

edited online, including assigning the student to the logged in user’s district.  Once the editing is complete, 

select the UPDATE STUDENT button. 
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If a student is enrolled in more than one district or school during the same school year, both enrollments 

will be seen in the Search.  For example, if a student is enrolled at a nonpublic system, but receives services 

from a public district, both the nonpublic system and the public district can have the student assigned to 

them at the same time. 

 

 

Please Note:  If student is known to have transferred in from another Nebraska school, public or 

nonpublic, and a student ID number cannot be found, please contact the NDE Helpdesk at 

ADVISERHelp@nebraska.gov for assistance in locating the student.  DO NOT assign a new ID number. 

  

mailto:ADVISERHelp@nebraska.gov


 
 

 pg. 19 

ADVISER PERSON ID 

3 APPENDIX A 

3.1 Creating a File for Upload 
To create a file to upload, start with a blank Excel spreadsheet (or use the template file posted in the 

ADVISER Resources website at https://www.education.ne.gov/dataservices/adviser-resources/) and 

format all cells to text.  To do this in most versions of Excel, highlight the entire blank spreadsheet by 

clicking on the box above the first row and to the left of the first column. 

 

Right click anywhere within the highlighted spreadsheet and from the popup menu that will display, 

click the Format Cells 

 

  

https://www.education.ne.gov/dataservices/adviser-resources/
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In the next popup box to display, click on Text and then click the OK button. 

 

A header row can be added in the first row to help the creator know what data to enter in each of the 

columns.  Then follow the example data from the Record Layouts below for the file format chosen and 

enter the data in the cells following the Sample Data. 

When all students’ data has been entered into the file, choose Save as to save the file as a .csv file.  

Instructions for saving the file can be found in the instructions for importing a text file into Excel in 

Appendix B.  There is no specific naming convention for the file name. 
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3.1.1 File Formats for File Upload – ADVISER Person ID or Legacy Student ID 
 

ADVISER Person ID file format  

File will need to be in either a .csv, .tab or .txt file type. 

 

Detailed Record Layout 
Column Letter or Number Field 

Name 

Required Data Type Notes/Format Details Sample Data 

 

Column A or 1 Person 

Unique ID 

No VarChar 

(10) 

Leave blank if this student has 

not yet been assigned an NDE 

Student ID.  Once assigned, all 

subsequent submissions for 

this student should include the 

assigned NDE Student ID. 

6789012345 

Column B or 2 Person 

First 

Name 

Yes VarChar 

(75) 

Student’s Legal First Name John 

Column C or 3 Person 

Last Name 

Yes VarChar 

(75) 

Student’s Legal Last Name  Doe 

Column D or 4 Person 

Middle 

Name 

No VarChar 

(75) 

Student’s Middle Name or 

Initial 

M 

Column E or 5 Person 

Name 

Suffix 

No VarChar 

(10) 

Student’s Suffix, (e.g., Jr., Sr., 

III) 

Jr 

Column F or 6 Gender Yes VarChar 

(20) 

M/F M 

Column G or 7 Person 

Date of 

Birth 

Yes VarChar 

(10) 

Required Format: 

MM/DD/YYYY 

01/30/1994 

Column H or 8 Person 

School 

Year 

Yes VarChar 

(8) 

Both years during the current 

school year (e.g., 20192020) 

20192020 

Column I or 9 Person 

District 

Code 

Yes VarChar 

(11) 

Nine Digit Current District in 

Which Student is Enrolled with 

hyphens (e.g., 99-9999-000) 

(must have leading zero if 

applicable) 

 

99-9999-000 

Column J or 10 District of 

Residence 

Yes VarChar 

(11) 

Nine Digit District in Which the 

Student Lives with hyphens 

(e.g., 99-9999-000) (must have 

leading zero if applicable) 

99-9999-000 

Column K or 11 Person 

School 

Code 

Yes VarChar 

(11) 

Nine Digit School Building in 

Which Student is Enrolled with 

hyphens (e.g., 99-9999-001) 
(must have leading zero if 

applicable) 

99-9999-001 
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Column Letter or Number Field 

Name 

Required Data Type Notes/Format Details Sample Data 

 

Column L or 12 Grade 

Level 

Yes VarChar 

(20) 

HP Half-Day 

Prekindergarten   

PK  Prekindergarten 

HK Half-Day 

Kindergarten 

KG Kindergarten 

01 Grade 1 

02 Grade 2 

03 Grade 3 

04 Grade 4 

05 Grade 5 

06 Grade 6 

07 Grade 7 

08 Grade 8 

09 Grade 9 

10 Grade 10 

11 Grade 11 

12 Grade 12 

PS Postsecondary 

AE Adult Education 
 

09 

Column M or 13 Person 

Local ID 

No VarChar 

(25) 

Student Local ID number 

ID used in the district student 

information system (SIS) to 

uniquely identify the student.  

This field provides a means to 

import student data from the 

Uniq-ID System back into the 

district SIS.   

123467 
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Legacy Student ID 

The Legacy Student ID format is the same as the one that has been used the last few years and is 

probably the format that the Student Information Systems are currently exporting. 

 

File will need to be saved as a .csv, .tab or .txt file type. 

 

Detailed Record Layout 
Column Letter or Number Field 

Name 

Required Data Type Notes/Format Details Sample Data 

 

Column A or 1 Record 

Type 

Yes VarChar 

(2) 

Always “ID”. ID 

Column B or 2 Current 

School 

Code 

Yes VarChar 

(6) 

School Code of school in which 

student is currently enrolled.  

(Must have leading zeros.) 

001 

Column C or 3 Resident 

District 

Code 

Yes VarChar 

(8) 

District Code of district in 

which student currently 

resides. 

99-9999 

Column D or 4 Last Name  Yes VarChar 

(60) 

Student’s Legal Last Name Doe 

Column E or 5 First 

Name 

Yes VarChar 

(60) 

 Student’s Legal First Name John 

Column F or 6 Middle 

Initial 

No VarChar 

(60) 

Student’s Middle Name or 

Initial 

M 

Column G or 7 Name 

Suffix 

No VarChar 

(10) 

Student’s Suffix, (e.g., Jr., Sr., 

III) 

Jr 

Column H or 8 Gender Yes VarChar 

(6) 

M/F M 

Column I or 9 Date of 

Birth 

Yes VarChar 

(10) 

Required format: 

“mm/dd/yyyy” 

01/30/1994 
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Column Letter or Number Field 

Name 

Required Data Type Notes/Format Details Sample Data 

 

Column J or 10 Current 

Grade 

Level 

Yes VarChar 

(2) 

Valid Values: 

HP Half-Day 

Prekindergarten   

PK  Prekindergarten 

HK Half-Day 

Kindergarten 

KG Kindergarten 

01 Grade 1 

02 Grade 2 

03 Grade 3 

04 Grade 4 

05 Grade 5 

06 Grade 6 

07 Grade 7 

08 Grade 8 

09 Grade 9 

10 Grade 10 

11 Grade 11 

12 Grade 12 

PS Postsecondary 

AE Adult Education 
 

09 

Column K or 11 Local 

Student ID 

Yes VarChar 

(20) 

ID used in the district student 

information system (SIS) to 

uniquely identify the student.  

This field provides a means to 

import student data from the 

Uniq-ID System back into the 

district SIS.   

123467 

Column L or 12 Social 

Security 

Number 

No VarChar 

(11) 

Optional. (blank) 
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Column Letter or Number Field 

Name 

Required Data Type Notes/Format Details Sample Data 

 

Column M or 13 Race / 

Ethnicity 

No VarChar 

(4) 

NOTE: Although the following 

values remain valid, NDE 

recommends leaving 

Race/Ethnicity blank on future 

submissions. 

Valid Values: 

blank  

AM American Indian or 

Alaska Native 

AS Asian or Pacific 

Islander 

BL Black (Not 

Hispanic) 

HI Hispanic 

WH White (Not 

Hispanic) 

PI Native Hawaiian or 

Other Pacific 

Islander 
 

(blank) 

Column N or 14 NDE 

Student ID 

No VarChar 

(25) 

Leave blank if this student has 

not yet been assigned an NDE 

Student ID.  Once assigned, all 

subsequent submissions for 

this student should include the 

assigned NDE Student ID. 

6789012345 

Column O or 15 Current 

District of 

Record 

Yes VarChar 

(8) 

District Code of district in 

which student is currently 

enrolled.  

99-9999 

Column P or 16 Current 

School 

Year 

Yes VarChar 

(10) 

Required format: a “yyyy”.  

Use “ending” year of school 

year, for example “2020” for 

2019-2020. 

2020 

 

3.1.2 Editing an Existing File for Upload 
If needing to edit an existing text file (.txt, .tab or .csv) from a previous school year’s student ID update 

DO NOT “open” the file by simply double clicking on it.  The file must be imported into Excel to make 

changes to the file.  Follow the instructions for importing a text file into Excel from Appendix B. 

 

When all data is complete in the file, the file will need to be saved again (Save as) as a .csv.  Instructions 

for saving the file again can be found in the instructions in Appendix B.  There is no specific naming 

convention for the file name. 
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4 APPENDIX B 

4.1 STEPS TO IMPORTING .csv or .txt file with Microsoft Excel 

In order to edit a .csv or .txt file, the file must first be imported into Excel.  Do Not OPEN a CSV 

or TXT file by double clicking on the file.  Once the corrections have been made, the file will need 

to be saved again as a CSV (Comma Delimited) (*.csv). 

Below are separate instructions for each version of Excel on how to IMPORT a .csv file. 

A.  Microsoft Excel 2007-2013 

B. Microsoft Excel 1997-2003 

4.2 Using Microsoft Excel 2007, 2010 and 2013 

NOTE: The steps below will work with the 2007-2013 Versions of Excel, though the program 

look and feel may be slightly different. 

1. Open a blank Excel spreadsheet. 
2. Select the Data tab from the top on the screen. 
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3. In the Get External Data group, click From Text. 
 

 

 

4. Browse to find the file (.csv or .txt) and click the Import button. 
Note: If the file does not appear; make sure All Files (*) is selected from the file drop down. 

 

  

  



 
 

 pg. 28 

ADVISER PERSON ID 

5. The Text Import Wizard will appear. The Delimited radial button is already selected. Click Next. 
 

 

 

 

6. Check the Comma checkbox.  Leave the Tab box selected.  Click Next. 
NOTE: The data in the preview window should display in columns if the correct delimiter (tab or 

comma) is selected. 
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7. Select all of the data in the Data preview window by using the scroll bar underneath. Only 
the first column is currently selected. 

 

 
 

Scroll to the very last column, click the SHIFT key on your keyboard and click on the last 
column. This will select all of the data. 
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8. Change the data format to text by selecting the Text radial button.  Click the Finish button.  All 
columns should have the Text heading. 

 

 

 

9. The Existing worksheet: can be left selected as the worksheet the data will be imported into. 
Select OK. 

 

 

 

 

4.2.1 Tip: To Replace Column Headings with numbers instead of letters (Optional): 
 

Microsoft 2007: Click the “Office” button, then Options, then Formulas = R1C1 Reference Style 

Microsoft 2010 and 2013: Click the “File” Tab, then Options, then Formulas = R1C1 Reference Style 
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4.2.2 Saving Corrections 
Once the file has been imported into Excel, the data can be reviewed for accuracy, corrections can be 
made or records can be deleted. 

Follow the steps below to save the file as a .csv (comma separated value) when changes have 

been completed. 

1. Click on File (in 2007 click on the “Office Button”) and choose Save As from the menu. 

 

 

 

2. Within the Save As window choose the folder/location where the file will be saved. 
3. Click on the dropdown arrow at the end of the Save As Type option and choose CSV (comma 

delimited). 
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4. Click Save. 

5. Two warning messages from Excel will display. Click OK and YES 

 

 

 
 
 
 
 

6. When closing the file, Excel will ask if changes need to be saved.  Click the Don’t Save. 
 

 

 

 

4.2.3 Using Microsoft Excel 1998-2003 
1. Open the Excel Program. 
2. Select the Data tab on the Ribbon at the top on the screen. Get External Data Import Text 

File. 
3. In the “Get External Data” group, click Import Text File. 
4. Browse to find the file (.csv or .txt) and click Open. Be sure to look for All files. 
5. The Delimited radial button should be selected. Click Next. 
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6. If the data in the Preview window is separated by commas (not displaying in columns) check 
the Comma checkbox.  The Tab box does not need to be deselected.  Click Next. 
NOTE: The data in the preview window should display in columns if the correct delimiter (tab or 

comma) is selected. 

 

7. Select all of the data in the Data preview window by using the scroll bar underneath. Only 

the first column is currently selected. 

 
 

Scroll to the very last column, click the SHIFT key on your keyboard and click on the last 
column. This will select all of the data. 
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8.    Change the data format to text by selecting the Text radial button.  All columns should have 
the Text heading.  Click the Finish button then Save. 

 

 

 

Follow Step 9 from previous instructions for the later versions of Microsoft Excel to complete the 
import. 

 

4.2.4 Tip for Microsoft Excel 1998-2003: To replace Column Headings with numbers 

instead of letters (Optional): 
Select Tools > Options.  In the General tab, check R1C1 reference style. 

 

 


